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Chapter 1
AutoCAD Fundamentals

Learming Qyjeciives

¢ Create and Save AutoCAD drawing files
¢ Use the AutoCAD visual reference
commands

¢ Draw, using the LINE and CIRCLE
commands

¢ Use the ERASE command

¢ Define Positions using the Basic Entry
methods

¢ Use the AutoCAD Pan Realtime option
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Introduction

Learning to use a CAD system is similar to learning a new language. It is necessary to
begin with the basic alphabet and learn how to use it correctly and effectively through
practice. This will require learning some new concepts and skills as well as learning a
different vocabulary. All CAD systems create designs using basic geometric entities.
Many of the constructions used in technical designs are based upon two-dimensional
planar geometry. The method and number of operations that are required to accomplish
the constructions are different from one system to another.

In order to become effective in using a CAD system, we must learn to create geometric
entities quickly and accurately. In learning to use a CAD system, lines and circles are the
first two, and perhaps the most important two, geometric entities that one should master
the skills of creating and modifying. Straight lines and circles are used in almost all
technical designs. In examining the different types of planar geometric entities, the
importance of lines and circles becomes obvious. Triangles and polygons are planar
figures bounded by straight lines. Ellipses and splines can be constructed by connecting
arcs with different radii. As one gains some experience in creating lines and circles,
similar procedures can be applied to create other geometric entities. In this chapter, the
different ways of creating lines and circles in AutoCAD® 2008 are examined.

Starting Up AutoCAD® 2008

1. Select the AutoCAD 2008 option on the Program menu or select the
AutoCAD 2008 icon on the Desktop. Once the program is loaded into
memory, the AutoCAD® 2008 drawing screen will appear on the screen.

I AdtoCAD z00a @ Windows Update

@ Accessaries
fﬁ Autodesk

3 % Autodesk DWF Yiewer

I@ Games v [ ] q ¥ Attach Digital Signatures
@ Startup » @ Autodesk Data Management ¥ AuboC

) WinRAR b ) ACEMiiew 2005 v
‘Q Inkernet Explorer @ Autodesk Invenkor 2003 4
@ Outlook Express E] Autodesk Design Review
i Remote Assistance

@ ‘Windows Media Player
All Programs 24 windows Messenger

Log Off @ Turn OFf Camputer
i istart @ ¢ [E 1 Inkernet |




AutoCAD Fundamentals 1-3

» Note that AutoCAD automatically assigns generic name, Drawing X, as new
drawings are created. In our example, AutoCAD opened the graphics window using
the default system units and assigned the drawing name Drawing].
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Drawing Units Setup

» Every object we construct in a CAD system is measured in units. We should
determine the value of the units within the CAD system before creating the first
geometric entities.

|F0rmat Tools Draw Dimension  Modi

B S Layer...

™ 0 Layer States Manager .. 1. Inthe pull-down menus, select:
Layer kools L4
Color.., .
R [Format] - [Units]
Linewseight...

Scale List. ..

&f' Text Style. ..

,.ﬁ Dimension Style, ..

ﬁ Table Style. ..

8# Multileader Style
Flat Stwle.. .
Point Style. ..
Multiline Skyle...

i ] Ihickness!
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2. Click on the Length Type option to display the different types of length units
available. Confirm the Length Type is set to Decimal.
@Drawing Units ﬂﬂ
— Length —Angle
Type: Type:
Drecimal I Decimal Degrees j
Architectural Precizion:
E ngineering I a j
Fractional
Scientific [T Clockwise
~ Inzertion zcale
itz to zzale inzerted content:
Ihches j
—Angle
Type:

Decimal Degrees

[Gradz

Decimal Degrees

Deg/MinSec

Radians
Surveyor's Units

3. On your own, examine the other settings that are available.

4. Inthe Drawing Units dialog box, set the Length Type to Decimal. This will

set the measurement to the default English units, inches.

@Drawing Units

— Length

Type:

—Angle
Type:

IDecimaI

Frecizion:

IDecimaI Degrees

Frecizion:

0.0aa0

1]
0.0

0,000
0.0000
0.00a00
0.000000
(.00a00a0
| 2.00000000

[o

[T Clockwise

— Sample Output

1.5000,2.0033,0.0000

figure.

5. Set the Precision to two digits after the decimal point as shown in the above

6. Pick OK to exit the Drawing Units dialog box.
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Drawing Area Setup

+ Next, we will set up the Drawing Limits; setting the Drawing Limits controls the
extents of the display of the grid. It also serves as a visual reference that marks the
working area. It can also be used to prevent construction outside the grid limits and
as a plot option that defines an area to be plotted/printed. Note that this setting does
not limit the region for geometry construction.

=2 Laver...

Laver tools
Colar,..
Linetype. ..
Lineweight. ..

Scale List. ..

= [ Layer States Manager. ..

|F0rmat Tools Draw Dimension  Modi

1. In the pull-down menus, select:

[Format] > [Drawing Limits]

&0" Texk Skyle...
@ Table Style...

Flot Stwle. ..
Boink Skyle. ..

,,ﬁ Dimension Style...

;(_)/ Multileader Style

Mulkiling Skyle.

Units. ..
=# Thickness

Rename. ..

&)

2.

In the command prompt area, near the bottom of the AutoCAD drawing
screen, the message “Reset Model Space Limits: Specify lower left corner or
[On/Off] <0.00,0.00>:" is displayed. Press the ENTER key once to accept the
default coordinates <0.00,0.00>.

Fe=zset Model space limit=:
Specify lower left corner or [OH-OFF] <0.00,0.00::

111.66, 2255 ,0.00 | sMaF| GRID| ORTHO|[POL2R [0S

\JCDmmand: ' limit=

In the command prompt area, the message “Specify upper right corner
<0.00,0.00>: is displayed. Press the ENTER key once to accept the default
coordinates <12.00,9.00>.

Specify upper right corner <12 .00.9.003:
Command

\}Specify lower left corner or [OH-OFF] <0.00.0.00x:

[13.26, 0.01 . 0.00

| sMaP| GRID| ORTHO| [POLAR

On your own, move the graphic cursor near the upper-right comer inside the
drawing area and note that the drawing area is unchanged. (The Drawing
Limits command is used to set the drawing area, but the display will not be
adjusted until a display command is used.)
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Bl autocAD 2008 - [Drawingl.dwa] .
E File Edit | view Insert Format Tools Draw  Dimension  Modify 5. In the pull-down menus, SeleCt'
[ 2D Drafting o Redraw W E| 2033 4
= Regen [View] = [Zoom] - [All]
Regen All
Q¢ geatims % The Zoom All command will adjust
ean : ® provious the d1'splay so'that all objects in the
orbit " @ windon drawing are displayed to be as large as
c . .
o . @ pynamic possible. If no objects are constructed,
alk and Fly @\ _— . Y )
Aerial View @ con the Drawing Limits are used to adjust
Center .
Clean Screen CTRL+0 @ Object the current VlCWpOI"[.
_ ewparts ' R 6. Move the graphic cursor near the
Mamed Yiews, ., a\ Qut . . . .
B b p— upper-right comer inside the drawing
ffil Create Camera area and note that the display area is
@\ Extenks

updated.
Using the InfoCenter to get more information

e Prior to creating geometric objects, let’s examine the usage of the InfoCenter
option to obtain some help on the subject.

1. Type Draw in the InfoCenter input box to
search for any Draw related information.

User's Guide

2. Click Draw Geometric Objects in the

o Draw Georndric Ohijects -
@ Create Multﬁ—\-"iew Drawing b AutOCAD Help list as shown.

La\,fuuts (F'aper Space)

AutoCAD 2008 User's Guide » Create and Modify Objects »

Draw Geometric Objects

3. Inthe AutoCAD 2008 User’s Guide,
general information regarding the
constructions of geometric objects is
described.

Drawings are made up of objects, In general, you draw objects by
specifying points with the pointing device or by entering coordinate values
at the command prompt.

¥ou can create a range of objects, from simple lines and circles to spline
curves, and ellipses. In general, you draw ohjects by specifying points with
the pointing device or by entering coordinate values at the command
prompt

4. Click Draw Linear Obijects to get more
information on how to construct Linear
Objects.

= Draw lineaObjects -

& lineg, the most basic object, can be one segment or a series of
connected segments,

= Draw Gurved Objects
Curved objects are arcs, circles, polyline arcs, donuts, ellipses, and

AutoCAD 2008 Command Reference » Commands > L commands > LINE >

LINE

5. On your own, click Draw Lines and then
Line to view the description of the
Creates straight line segments AutOCAD Line COl’IlmaIld.

8 Toolbar: Draw

8 Menu: Draw > Line

Procedure

Concept Quick Reference

e On your own, read through the
descriptions listed in Concepts.

EE command entry: line

Specify first point: Specify 2 point or press ENTER to continue from the last Procedure and Quick Reference.

drawr lire or 3¢
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Drawing lines with the LINE command

ESH E]
-] =l = @ 1. Move the graphics cursor to the first icon in the
= == 2D Draw and Modify panel. This icon is the Line
[Unsaved Layer state ] & icon. A help-tip box appears next to the cursor.
AL |

A /20070,
B EBE+O_ | 2. Select the icon by clicking once with the left-

o & & 5 mouse-button, which will activate the Line
command.
©.

L Y

3. In the command prompt area, near the bottom of the AutoCAD drawing screen,
the message “ line Specify first point:” is displayed. AutoCAD expects us to
identify the starting location of a straight line. Move the graphics cursor inside
the graphics window and watch the display of the coordinates of the graphics
cursor at the bottom of the AutoCAD drawing screen. The three numbers
represent the location of the cursor in the X, Y, and Z directions. We can treat the
graphics window as if it was a piece of paper and we are using the graphics
cursor as if it were a pencil with which to draw.

hr
1

A
Coordinates of the location 4L 4lp [y Model  Layout? { Layout2 /
of the graphics cursor.
Coranarnd :
Command: line 3pecify first poin

4.87. 3.03.0.00 SH&P| GRID| ORTHO

PO

0,

¢ We will create a freehand sketch of a five-
point star using the Line command. Do not
be overly concerned with the actual size or
the accuracy of your freehand sketch. This
exercise is to give you a feel for the
AutoCAD® 2008 user interface.
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4. We will start at a location about one-third from the
bottom of the graphics window. Left-click once to
position the starting point of our first line. This will
be point I of our sketch. Next move the cursor
upward and toward the right side of point 1. Notice
the rubber-band line that follows the graphics cursor
in the graphics window. Left-click again (point 2)
and we have created the first line of our sketch.

LR \ModelA Layoutl A Layoui f

5. Move the cursor to the left of point 2 and create a
Folari 4.01 < 100° horizontal line about the same length as the first
line on the screen.

6. Repeat the above steps and complete
the freehand sketch by adding three
more lines (from point 3 to point 4,
point 4 to point 5, and then connect to
point 5 back to point I).

W 7. Notice that the Line command remains activated even after
Canicel we connected the last segment of the line to the starting
Recent Input 0 point (point 1) of our sketch. Inside the graphics window,
click once with the right-mouse-button and a popup
Close menu appears on the screen.
Unda
Snep Oyerrides 8. Select Enter with the left-mouse-button to end the Line
= command. (This is equivalent to hitting the [ENTER] key
&% pan on the keyboard.)
C% £00m
9. On your own, move the cursor near point 2 and point 3,
B uickcale and estimate the length of the horizontal line by watching

the displayed coordinates for each point.
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Visual reference

The method we just used to create the freehand sketch is known as the interactive
method, where we use the cursor to specify locations on the screen. This method is
perhaps the fastest way to specify locations on the screen. However, it is rather difficult
to try to create a line of a specific length by watching the displayed coordinates. It would
be helpful to know what one inch or one meter looks like on the screen while we are
creating entities. AutoCAD® 2008 provides us with many tools to aid the construction of
our designs. We will use the GRID and SNAP options to get a visual reference as to the
size of objects and learn to restrict the movement of the cursor to a set increment on the
screen.

The Status Bar area is located at the bottom of the AutoCAD drawing screen. The words
SNAP, GRID, ORTHO, POLAR, OSNAP, OTRACK, DUCS, LWT and MODEL appearing
to the right of the coordinates are buttons that we can left-click to turn these special
options ON and OFF. When the corresponding button is highlighted, the specific option
is turned ON. These buttons act as toggle switches; each click of the button will toggle
the option ON or OFF. Using the buttons is a quick and easy way to make changes to
these drawing aid options. We can toggle the options on and off in the middle of another
command.

O0— X

[ 4p TH] Model  Lapounl J Lapoutz 14 [

H Coroard : Option Buttons
Command: =0 02 o a-=m——mm T === «- - _ _

201, 0,31, 0.00 ¢ [ sneF| GRID| 0RTHO| [PoLaR [osheP [oTRaCK [oucs MJ MDDE,L

GRID ON

1. Left-click the GRID button in the Status Bar to turn ON the GRID option. (Notice
in the command prompt area, the message “<Grid on>" is also displayed.)

Cpecify next point or [Close-Tndo]:
Cpecify next point or [ClosesUndo]:
Command: <{Grid on>

Commarnd
|[4.8412 36373, 0.0000 |SNAP||GFT~J\D ORTHO|[POLAR
M

2. Move the cursor inside the graphics window, and estimate the distance in between
the grid points by Watching the coordinates display at the bottom of the screen.

l_> 4% i_ﬁbﬁxﬁ | 4%

4 4 ) )I Model Layout‘l Layout? 4] 4 » [ MY Model {Lapout! { Lavout? [
Specify next point or [ClosesTndo]: Specify next point or [ClosesUndo]:
Command: <Grid on: Command: <Grid on:

Command : Commarnd :

20014, 05251, 0.0000 SNAP|GRID O 25048, 0.5107 , 0.0000 SMNAP |GRID OR
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' 4%* ' W » The GRID option creates a pattern of dots

that extends over an area on the screen.
Using the grid is similar to placing a sheet
of grid paper under a drawing. The grid
helps you align objects and visualize the
distance between them. The grid is not
displayed in the plotted drawing. The
default grid spacing, which means the
distance in between two dots on the screen,
is 0.5 inches. We can see that the sketched
horizontal line in the sketch is about 4.0
inches long.

K )I|\. Modei'(Layo.ul'I ;(Layouth

SNAP ON
1. Left-click the SNAP button in the Status Bar to turn ON the SNAP option.
v
4[4[ [0 [h Model fLapout] {Layout?

JJCDmmand: <Grid on>

CoroenErd @
0.30, 0.06, 0.00 | SN&P|[GRID ORTHO||POLAR [DSNAP [OTRACK [DUCS D
by

2. Move the cursor inside the graphics window, and move the cursor diagonally
on the screen. Observe the movement of the cursor and watch the coordinates
display at the bottom of the screen.

» The SNAP option controls an invisible rectangular grid that restricts cursor
movement to specified intervals. When SNAP mode is on, the screen cursor and
all input coordinates are snapped to the nearest point on the grid. The default snap
interval is 0.5 inches, and aligned to the grid points on the screen.

'I':i\_r‘l_l'_-_ I

A /o027 0,
2 &BEH O,

hd

3. Click on the Line icon in the 2D Draw and
Modify toolbar. In the command prompt area,
the message “ line Specify first point:” is
displayed.
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4. On your own, create another sketch of the five-point star with the GRID and
SNAP options switched ON.

NIE IR EI I R EEEEEE
=]

“I 2D Drafting & Annatation j Ty

Cancel !

E—— » || 5. Use the right-mouse-button and select Enter in the popup
menu to end the Line command if you have not done so.

Close

Undo

Snap Owerrides 4

Using the ERASER command

% One of the advantages of using a CAD system is the ability to remove entities without
leaving any marks. We will erase two of the lines using the Erase command.

El =l
= 2= |8 1. Pick Erase in the 2D Draw and Modify toolbar.
[unsaved Layer state > (The icon is the first icon in the Modiify toolbar. The
£|V0%Tmo =] icon is a picture of an eraser at the end of a pencil.)

The message “Select objects” is displayed in the
command prompt area and AutoCAD awaits us to
select the objects to erase.

[ /Jamr@_

S &5
% &£

& &
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2. Left-click the SNAP button on the Status Bar to turn OFF the SNAP option so
that we can more easily move the cursor on top of objects. We can toggle the
Status Bar options ON or OFF in the middle of another command.

Conmand :
Command :

_erase

Select ohjects:

<8nap off>

[10.273%, 4.0558, 0.0000

| SNAR|GRID ORTHO|

SﬁgpMDdE

3. Select any two lines on the screen; the selected lines are displayed as dashed
lines as shown in the figure below.

Select objecks:

4. Right-mouse-click once to accept the selections. The selected two lines are

erased.

Repeat the last command

BN

Recent Input

=8 Cut
Copy

Copy with Base Point
’fﬁ; Paste

Faste as Black

CTRL+3
CTRL+C
CTRL+SHIFT+C
CTRL+Y
CTRL+SHIET+Y

Faste to Original Coordinates

+ Undo Erase
& Redo

s

2 Pan

Q Zoorm

CTRL+Y

Quick Select...
E QuickCalc
(e Find, .,

Options, .,

1.

Inside the graphics window, click once with the right-
mouse-button to bring up the popup option menu.

Pick Repeat Erase, with the left-mouse-button, in the
popup menu to repeat the last command. Notice the other
options available in the popup menu.

AutoCAD® 2008 offers many options to accomplish the
same task. Throughout this text, we will emphasize the
use of the AutoCAD Heads-up Design™" interface,
which means we focus on the screen, not on the
keyboard.
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3. Move the cursor to a location that is above and toward the left side of the
entities on the screen. Left-mouse-click once to start a corner of a rubber-band

window.

El autoCaD 2008 - [Drawing1.dwg] ' =10l x|
E File Edit Wiew Insert Format Tools Draw  Dimension  Modify  Window Help |Typeaquestion far help 2 - |% % ;Iilll

J“ 20 Dirafting & Annotation jﬁi‘t“JD&'%@@&'fﬁ' |§agﬂﬁ|ﬂ|
IUnsaved Layer State 'l =
ii‘llJQ‘?:i]fn"_’?ID j

. /Firstcorner . . . . L . L . — T
S4B MERES O,
L £ L L
= H|HS F RO,
. I Standard vl,,ﬁ
i A A A | a5
g I Standard vl&*
Jozo =l
q° Pl &l o
I Standard VI Pj
EE ElEE:
/ IStandard 'lﬁ
| Second corner ¥ | SR
@] [
A AF [P]y Model { Capoutl 7 Layout2 7 1 1

4. Move the cursor toward the right and below the entities, and then left-mouse-
click to enclose all the entities inside the selection window. Notice all entities
that are inside the window are selected.

5. Inside the graphics window, right-mouse-click once to proceed with erasing
the selected entities.

» On your own, create a free-hand sketch of your choice using the Line command.
Experiment with using the different commands we have discussed so far. Also try
switching the GRID and SNAP options ON and OFF in the middle of a command.

|_|_’T;/
4[4[ [0 [h Model fLapout] {Layout?

JJCDmmand: <Grid on>

Cortosrd

0.30, 0.06, 0.00 | SN&P|[GRID ORTHO||POLAR [DSNAP [OTRACK [DUCS D
by
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The CAD Database and the User Coordinate System

+» Designs and drawings created in a CAD system are
usually defined and stored using sets of points in
what is called world space. In most CAD systems,
L the world space is defined using a three-dimensional
Cartesian coordinate system. Three mutually
perpendicular axes, usually referred to as the X-, Y-,
- “ and Z-axes, deﬁne this system. The i.ntersection of
v 2. T the three coordinate axes forms a point called the
- 2 L . . .
- = - origin. Any point in world space can then be defined
as the distance from the origin in the X-, Y- and Z-
directions. In most CAD systems, the directions of
the arrows shown on the axes identify the positive
sides of the coordinates.

A CAD file, which is the electronic version of the design, contains data that describe the
entities created in the CAD system. Information such as the coordinate values in world
space for all endpoints, center points, etc., along with the descriptions of the types of
entities are all stored in the file. Knowing that AutoCAD stores designs by keeping
coordinate data helps us understand the inputs required to create entities.

3D UCS icon

. ’

N . o X‘/, . . : :
b P

I [ €[> w5 Fodel {Layout] £ Lapout?

The icon near the bottom left corner of the default AutoCAD graphics window shows the
positive X-direction and positive Y-direction of the coordinate system that is active. In
AutoCAD, the coordinate system that is used to create entities is called the user
coordinate system (UCS). By default, the user coordinate system is aligned to the
world coordinate system (WCS). The world coordinate system is a coordinate system
used by AutoCAD as the basis for defining all objects and other coordinate systems
defined by the users. We can think of the origin of the world coordinate system as a
fixed point being used as a reference for all measurements. The default orientation of the
Z-axis can be considered as positive values in front of the monitor and negative values
inside the monitor.
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Changing to the 2D UCS icon Display

< In AutoCAD® 2008, the UCS icon is displayed in various ways to help us
visualize the orientation of the drawing plane.

L N <€ <

20UC=at  right side viewe  iza viewe of 20D UCS viewwed
WiCS of 20 UCE 2D UCs from below

= 7 i
%‘r
L—b‘r’ l—b“f X
D UCEat  right side viewe  iza viewe of 30D UCS viewwed
WiCS of 30 UCE 3D UCs from below

A

[EH AutoCAD 2008 - [Drawing1.dwg]
"8 File Edt | yiew Insert Format Tools Draw Dimenson Modify Window Help

BT 2E|2RD S| #C- 1. In the pull-down menus, select:

[View] = [Display] -
[UCS Icon] - [Properties]

»
»
Orbit 4
»
walk and Fly 4
Aerial View

Clean Sgreen CTRL+D

YieWports 4

(£ Mamed Yiews. ..

il Create Camera

Show Annotative Objects 4

imal
. ispla UCs lean
aolars... spl
eras
[v]uights
H Text Window Fz

AIAIETH], Model /Tepou f Ly ], 141

2

2. Inthe UCS icon style section, - UCS con syl - Preview

switch to the 2D option as e W Cone

shown p ("%D Line width; m /Y\

- I~
—UCS icon zize

3. Click OK to accept the settings. [ g — >>
+ Note the W symbol in the UCS ‘UES:T" T | o

. . . . . odel space 1ICon color: anout bab icon color:

icon indicates the UCS is aligned C i | I.y " |

to the world coordinate system.

’TI Cancel | Help |
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Cartesian and Polar Coordinate Systems

In a two-dimensional space, a point can be represented using different coordinate
systems. The point can be located, using a Cartesian coordinate system, as X and Y units
away from the origin. The same point can also be located using the polar coordinate
system, as r and 0 units away from the origin.

%

For planar geometry, the polar coordinate system is very useful for certain applications.
In the polar coordinate system, points are defined in terms of a radial distance, r, from the
origin and an angle 0 between the direction of r and the positive X axis. The default
system for measuring angles in AutoCAD® 2008 defines positive angular values as
counter-clockwise from the positive X-axis.

Absolute and Relative Coordinates

e AutoCAD® 2008 also allows us to use absolute and
o relative coordinates to quickly construct objects.
| Absolute coordinate values are measured from the
A current coordinate system's origin point. Relative
% o coordinate values are specified in relation to previous
RIADE V], Model £ Lapauti coordinates.

as a toggle switch; each left-mouse-click will toggle

JJ Command: <Snap on> || > Note that the coordinate display area can also be used
the coordinate display on or off.

Cortosrd

2.00, 250, 0.00 | [sHar

In AutoCAD® 2008, the absolute coordinates and the relative coordinates can be used in
conjunction with the Cartesian and polar coordinate systems. By default, AutoCAD
expects us to enter values in absolute Cartesian coordinates, distances measured from the
current coordinate system's origin point. We can switch to using the relative coordinates
by using the @ symbol. The @ symbol is used as the relative coordinates specifier,
which means that we can specify the position of a point in relation to the previous point.
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Defining Positions

In AutoCAD, there are five methods for specifying the locations of points when we
create planar geometric entities.

>

>

Interactive method: Use the cursor to select on the screen.

Absolute coordinates (Format: X,Y): Type the X and Y coordinates to locate the
point on the current coordinate system relative to the origin.

Relative rectangular coordinates (Format: @X,Y): Type the X and Y
coordinates relative to the last point.

Relative polar coordinates (Format: @Distance<angle): Type a distance and
angle relative to the last point.

Direct Distance entry technique: Specify a second point by first moving the
cursor to indicate direction and then entering a distance.

The GuidePlate

We will next create a mechanical design using the different coordinate entry methods.

Use the Erase command and erase all entities on the screen before proceeding to the
next section.
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R/

¢ The rule for creating CAD designs and drawings is that they should be created at full
size using real-world units. The CAD database contains all the definitions of the
geometric entities and the design is considered as a virtual, full-sized object. Only
when a printer or plotter transfers the CAD design to paper is the design scaled to fit
on a sheet. The tedious task of determining a scale factor so that the design will fit on
a sheet of paper is taken care of by the CAD system. This allows the designers and
CAD operators to concentrate their attention on the more important issues — the

design.
EoHE a 1. Select the Line command icon in the 2D Draw
211 = k- and Modify toolbar. In the command prompt area,
= = near the bottom of the AutoCAD graphics
[unsaved Layer state =] 45 window, the message “ line Specify first point:”
AFEEELE =] is displayed. AutoCAD expects us to identify the

A Y YT ) starting location of a straight line.
2B &85+ O_ N 2 Inthe command prompt area, we will locate the
& & &S starting point of our design at the origin of the
world coordinate system.
©, Command: _line Specify first point: 0,0 [ENTER]
(Type 0,0 and press the [ENTER] key once.)

L Y

3. We will create a horizontal line by entering the absolute coordinates of the
second point.

Specify next point or [Undo]: 5.5,0 [ENTER]

o
AN
V/ -
[ 4] Ak M Model  Layoutl £ Lapou2 / 14 [ >|_I
HSpecif? next point or [Undo]: 5.5,0 =
Specify next point or [Undo]: 4| I ﬂ
7.19, 1.89.0.00 | 5MAP|[GRID ORTHO||POLAR |0sMaP [0TRacK [DUCS DYN| LwT) [MODEL Annota
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e The line we created is aligned to the bottom edge of the drawing window. Let us
adjust the view of the line by using the Pan Realtime command.

TE =

I Standard j ﬂ
S x| a @
®| So—

4. Click on the Pan Realtime icon in the 2D
Navigate toolbar panel. The icon is the picture
of a hand with four arrows.

+¢ The Pan command enables us to move the
view to a different position. This function acts
as if you are using a video camera.

5. Move the cursor, which appears as a hand inside the graphics window, near
the center of the drawing window, then push down the left-mouse-button and
drag the display toward the right and top side until we can see the sketched
line. (Notice the scroll bars can also be used to adjust viewing of the display.)

6. Press the [Esc] key to exit the Pan command. Notice that AutoCAD goes
back to the Line command.

7. We will create a vertical line by using the relative rectangular coordinates
entry method, relative to the last point we specified:

Specify next point or [Close/Undo]: @0,2.5 [ENTER]

8. We can mix any of the entry methods in positioning the locations of the
endpoints. Move the cursor to the Status Bar area, and turn ON the GRID and

SNAP options.
AUndo]:  <Snap on>
ATIndao ]_ o
SNAP[GRID DRTHO|
SNAP & GRID ON

9. Create the next line by picking the location, world coordinates
(8,2.5), on the screen.

Specify nex
Specify nex

H Feszumning LI

|2.00, 250,000

10. We will next use the relative polar coordinates entry method, relative to the
last point we specified:

Specify next point or [Close/Undo]: @3<90 [ENTER]
(Distance is 3 inches with an angle of 90 degrees.)
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TN : : 11. Using the relative rectangular
i coordinates entry method to

L-l 7 _ _ create the next line, we can

imagine a reference coordinate
Reference Coordinate System system aligned at the previous
aligned at the previous point | - | - point. Coordinates are measured
along the two reference axes.

Specify next point or [Close/Undo] :
@-1.5,1 [ENTER]

(1.5 and 1 inches are measured
relative to the reference point.)

L2

12. Move the cursor directly to the left of the last point
and use the direct distance entry technique by
entering 6.5 [ENTER].

=esTndo] ;. @3<90
=z Tndo]: @-1 .51

=z Tndo]: 6.5

| |[sner [GRID ORTHO| [POLsR

0

et 13. For the last segment of the sketch, we can use the Close
Cancel option to connect back to the starting point. Inside the
Recent Input . graphics window, right-mouse-click and a popup menu

m appears on the screen.
Unida

14. Select Close with the left-mouse-button to connect back to
Snap Cverrides 3 the starting point and end the Line command.
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Creating Circles

The menus and toolbars in AutoCAD® 2008 are designed to allow the CAD operators to
quickly activate the desired commands. Besides using the Draw toolbar, we can also
select the different Draw commands through the pull-down menus.

1. In the pull-down menus, select:

[Draw] - [Circle] > [Center, Diameter]

El autoCAD 2008 - [Drawingl.dwg]
EFile Edit Wiew Insert Fotmat Tools | Draw Dimension  Modify  Window  Help Ty

Modeling

JJI 20 Drafting & Annotation j ﬁ ii-t

—

'

/ Line

. Ray

f Construction Line

Multiling

‘Pl £ -V H

— Polyline

2, 3D Polyline

- SR Palygon

T Rectangle

= Helix

Arc

: @ Cronut
. ,'\-" Spline

Ellipse
Block,

4 @ Cenker, Radius

(-] Center, Diameter

() 2 Points
. .
o (_. 3 Painks

{5 Table...

Paint

. ﬁ Hatch, ..

f;} Tan, Tan, Radius

Tan, Tan, Tan

: l Gradient, ..

. H Boundarsy. ..

@ Region

Wipeaouk

Notice the different options available under the circle submenu:

e Center Point: Draws a circle based on a center point and a diameter or a radius.

e 2 Points: Draws a circle based on two endpoints of the diameter.

e 3 Points: Draws a circle based on three points on the circumference.

e TTR-Tangent, Tangent, Radius: Draws a circle with a specified radius

tangent to two objects.

e TTT-Tangent, Tangent, Tangent: Draws a circle tangent to three objects.
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2. Inthe command prompt area, the message “Specify center point for circle or
[3P/2P/Ttr (tan tan radius)]:” is displayed. AutoCAD expects us to identify
the location of a point or enter an option. We can use any of the four
coordinate entry methods to identify the desired location. We will enter the
world coordinates (2.5,3) as the center point for the first circle.

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 2.5,3 [ENTER]

3. In the command prompt area, the message “Specify diameter of circle:” is
displayed.

Specify diameter of circle: 2.5 [ENTER]

Repeat Center Diameter 4. Inside the graphics window, right-mouse-
click to bring up the popup option menu.

Recent Imput »

= Cub CTRL+2
Copy CTRL+C
Copy with Base Paink CTRL+SHIFT+C
€4 paste CTRL+Y
Paste as Block CTRL+ASHIET+Y

Faste to @riginal Coordinates

5. Pick Repeat Center, Diameter with the
left-mouse-button in the popup menu to
repeat the last command.

6. Using the relative rectangular coordinates
entry method, relative to the center-point
coordinates of the first circle, we specify the
location as (2.5,2).

' Undo Center, diameter

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: @2.5,2 [ENTER]
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7. In the command prompt area, the message “Specify Diameter of circle:
<2.50>" is displayed. The default option for the Circle command in
AutoCAD is to specify the radius and the last radius used is also displayed in

brackets.

Specify Diameter of circle<2.50>: 1.5 [ENTER]

Saving the CAD Design

JJ£ D Mew, .
Bl Mew Sheet Set, ..
1:;,{ Qpen...
Cpen Sheet Set. ..
@ Load Markup Set. ..
Close

Fartial Load

Rl autoCAD 2008 - [Drawingl.dwg]
S| File Edit Wiew Insert Format Tools D

CTRL+M

CTRL+O

Import,..

Save

CTRL+S
CTRL+SHIFT+3

1. In the pull-down menus, select:
[File] > [Save As]
+ Note the command can also be activated

with quick-key combination of
[Ctri]+[Shift]+[S].
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2. Inthe Save Drawing As dialog box, select the folder in which you want to
store the CAD file and enter GuidePlate in the File name box.

Ellsave Drawing As 2=l
Save in: I[E.AE:&D Projects j @ or @ W r Miews v Tods v
C— I —1 [ Preview
M4 1a.dwg N Select the folder
% 4 _TitleBlk, dwag to store the file.
iBase_PIate.dwg EER S
iBearing.dwg 46 K
iCap-screwD.dwg 1K
iCap-screw.dwg 36K
icapuleti-plan-SS.dwg 507 K
M CH4TUT.DWG 56 K
CHETUT . DWWG 44 k.
TMCHITUT. DWW G 3K
iCDIIar.dwg 41K
8 Cornetta-1.dwg 7K
8 Cornetta, dwg 586
% dd 16081 .dwg BEE
i o .
g = | Enter GuidePlate
[~ Update shest wigw thumbnails now
File name: |GuidePIate.dwg j Save |
[
Files of type: | AutoCAD 2007 Draviing (" dw] | ﬂ|

3. Pick Save in the Save Drawing As dialog box to accept the selections and
save the file.

Exit AutoCAD 2008

Bl autoCaD 2008 - [Dra dwg
S File Edt ¥iew Insert Format Tools D

It ? N oot .. e % To exit AutoCAD® 2008, select File then choose Exit
S g cre from the pull-down menu or type QUIT at the command

Open Sheet Set...

£3) Load Maripp ... prompt. Note the command can also be activated with

Close

parti Lo quick-key combination of [Ctrl]+[Q].

Import...

Save CTRL+S
Save As... CTRLASHIFT+5
ﬁ eTransmit...
Q Fublish ko Web. ..
Export...

E Page Setup Manager, ..
Plotter Manager...
Plot Style Manager. ..
@ Plot Prewiew
5 Plat... CTRL+P
= Publish, ..

‘iewe Plot and Publish Details, ..

Drawing Utilities L3
send. ..

Drawing Properties. ..

1F:Programt).. \CHZ-2.DWS
2 F:\Programi)...\Bracket.dwg

|
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Questions:
1. What are the advantages and disadvantages of using CAD systems to create
engineering drawings?
2. How do the GRID and SNAP options assist us in sketching?
3. List and describe the different coordinate entry methods available in AutoCAD?
4. List and describe two types of coordinate systems commonly used for planar
geometry.
5. Identify the following commands:
(a)
(b)
(c)
(d)

Tan, Tan, Radius
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Exercises: (All dimensions are in inches.)

1.
"7 1.00 4“‘7 0,750 — =
h
/ |
1.50
125 ]
0.50
0.25 F
* -l 2o -
g 2.00
2.
- 4,25 -]
P 1,010 = ‘
[
21,00

@1.00

=50 &D = 00
@200 10 \

- 200 -
- 2.2l -
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L30

&.50
=— 1,50 2.30
1.00_ - 1.00 e
4,00
4/ -
-—1.754
275
- 4,75 -
1,25 |
l—0.25
N * \
—~ 45 0.20 457
t A4
I E— 0125 /
125 075 |—o020 050
050
_r 0125 \
T \( * 0,375
hes -] 4T* 0.20 -
& i 45
+U.E5-—| ’
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NOTES:
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